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Documentation Updates

The title page of this document contains the following identifying information:

¢ Software Version number, which indicates the software version.

o Document Release Date, which changes each time the document is updated.

o Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and log on. To register for an HP Passport
ID, goto:

http://h20229.www2.hp.com/passport-registration.htmi
Or click the New users - please register link on the HP Passport log on page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support Online web site at:
http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed to manage your business. As a
valued support customer, you can benefit by using the support web site to:

o Search for knowledge documents of interest

o Submit and track support cases and enhancement requests
o Download software patches

« Manage support contracts

e Look up HP support contacts

¢ Review information about available services

¢ Enterinto discussions with other software customers

o Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.htmi
To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Disclaimer for PDF Version of Online Help

This document is a PDF version of the online help. This PDF file is provided so you can easily print
multiple topics from the help information or read the online help in PDF format.

Note: Some topics do not convert properly to PDF, causing format problems. Some elements of
online help are completely removed from the PDF version. Those problem topics can be
successfully printed from within the online help.
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About this Guide

Welcome to the Taxonomy Editor User Guide. This guide describes how to use Taxonomy Editor
as part of HP Enterprise Maps (HP EM).

This guide contains the following chapters:

"Taxonomy Editor" (on page 9)

Provides an overview of the main features of Taxonomy Editor.

"Getting Started" (on page 15)

Describes the installation of the main features and shows you how to create a taxonomy project.

"Managing Taxonomies" (on page 21)

Explains how to create, download, edit, and compare taxonomies.

"Deploying Taxonomies" (on page 27)

Shows how to publish taxonomies and build and deploy a Taxonomy Extension.

"Conflicts and Validation Issues" (on page 32)

Shows how to resolve conflicts with taxonomies.

"Example: Creating and Publishing a Department Taxonomy" (on page 34)

A walkthrough example of creating and deploying a new taxonomy.

"Keyboard Shortcuts" (on page 35)

Keyboard shortcuts reference.

"Dialog Boxes Reference" (on page 37)

Dialog box reference.

"Troubleshooting" (on page 39)

Troubleshooting tips.
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Chapter 1

Taxonomy Editor

HP EM Workbench is a set of Workbench features that enable you to manage taxonomies in HP
EM.

You can use Taxonomy Editor to create, modify, and delete taxonomies. You can also download
taxonomies from, or upload them to, any number of HP EM servers.

This chapter introduces Taxonomy Editor in the following sections:

o "Workbench Suite" (on page 9)

e "Overview" (on page 9)

o "User Interface" (on page 10)

Workbench Suite

HP EM Workbench is a suite of editor tools enabling you to customize your deployment of HP EM.

Workbench consists of the following editor tools, distributed as a single Eclipse development
platform:

e Customization Editor

Customizes the underlying SOA Definition Model (SDM) within HP EM.
e Taxonomy Editor

Customizes the taxonomies used to categorize artifacts in HP EM.
o Assertion Editor

Customizes the conditions applied by your business policies within HP EM.
o Report Editor

Customizes report definitions for use with HP EM.

Overview

Taxonomies are, in their simplest form, a visual representation of what your organization actually
knows. A well-constructed, meaningful taxonomy enables users in your organization to quickly find
the information they need to achieve their goals.

Taxonomy Editor enables you to organize and reorganize content easily, giving more flexibility for
knowledge sharing in your organization

Use Taxonomy Editor to do the following:
1. Create a Taxonomy Project.

For details, see the following sections:
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= "Creating a Taxonomy Project" (on page 17)

= "Downloading Taxonomies from a Server" (on page 18)

» "Searching for Taxonomies" (on page 18)

2. Create and Manage Taxonomies.
For details, see the following sections:

= "Creating Taxonomies" (on page 21)

= "Editing Taxonomies" (on page 21)

= "Editing Categories" (on page 22)

= "Deleting and Restoring Taxonomies" (on page 24)

» "Comparing Taxonomy Files" (on page 25)

» "Updating Taxonomies from the Server" (on page 25)

» "Importing and Exporting Taxonomy Files" (on page 25)

3. Publish taxonomies to an HP EM server.
For details, see the following sections:

= "Publishing Taxonomies" (on page 27)

= "Deploying Taxonomies" (on page 27)

4. Check local validity and manage conflicts.

For details, see "Conflicts and Validation Issues" (on page 32).

User Interface
The default perspective is split into a number of sections, with menu options across the top.
The platform perspective consists of the following views:
¢ Project Explorer

The tree view of your taxonomy projects. For details, see "Project Explorer" (on page 10).

e Server Explorer

The view listing HP EM server connections to the Workbench. For details, see "Server Explorer"

(on page 11).
o Editor

The view showing the components of the taxonomy. For details, see "Editor View" (on page 12).

Project Explorer

Project Explorer contains a hierarchical list of projects, the taxonomies in each project, and the
categories and subcategories of each taxonomy, as shown in the following screenshot.

The Project Explorer contains additional context menu options enabling you to interact with a
running HP EM server. Right-click the project name or a particular assertion, and select HP EM to
view the options listed in the following tables.
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Project Context Menu Options

Option Function

Download Import taxonomies from HP EM. For details, see "Downloading Taxonomies from
Taxonomies | a Server" (on page 18).

Upload to Export taxonomies to the default HP EM server. For details, see "Publishing
Server Taxonomies" (on page 27).

Update from | Update taxonomies from HP EM. For details, see "Updating Taxonomies from the
Server Server" (on page 25).

Remove Delete taxonomies from HP EM. For details, see "Deleting and Restoring

from Server | Taxonomies" (on page 24).

Upload To Export taxonomies to a specified HP EM server.

Other

Server

Build Create a taxonomy extension for HP EM containing all the taxonomies in your
Extension project. For details, see "Building a Taxonomy Extension" (on page 27).

Taxonomy Context Menu Options

Option Function

Upload to Server

Export a taxonomy to the default HP EM server. For details, see "Publishing
Taxonomies" (on page 27).

Update from Update a taxonomy from HP EM. For details, see "Updating Taxonomies
Server from the Server" (on page 25).

Remove from Delete the taxonomy from HP EM. For details, see "Deleting and Restoring
Server Taxonomies" (on page 24).

Upload To Other | Export a taxonomy to a specified HP EM server.

Server

Validate Data
Consistency

Check the validity of the taxonomies. For details, see "Conflicts and
Validation Issues" (on page 32).

Show Taxonomy
Usage

Find the artifacts that use the taxonomy for categorization. For details, see
"Conflicts and Validation Issues" (on page 32).

Compare With
Latest From
Server

Compares the selected taxonomy with the latest version on the server.

Build Extension

Create a taxonomy extension for HP EM containing all the taxonomies in your
project. For details, see "Building a Taxonomy Extension" (on page 27).

Server Explorer

The Server Explorer displays the HP EM servers connected to Workbench. The functionality is
shared by all the Workbench editors.
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Right-click a server in the Server Explorer to open the context menu described in the following
table.

Server Explorer Context Menu Options

Option Function

New Server | Add a server for downloading assertions and taxonomies (Assertion Editor,
Taxonomy Editor, and Customization Editor).
Remove Delete a server from the Server Explorer.
Server
Download Download a taxonomy from a server (Taxonomy Editor and Customization
Taxonomy Editor).
Download Download assertions from a platform server (Assertion Editor).
Assertion
Download Download reports from a reporting server (Report Editor).
Report
Properties View and edit the server name, URL, username, and password.
Editor View

The Editor pane is the main feature of the Taxonomy Editor UI.
It has four tabs, described in the following sections:

o Overview Tab

The Overview tab shows the components of the taxonomy.
The first section is General Information, where you can view and edit the following properties:
= Name

Name for the taxonomy. The content of the name element in the taxonomy's XML
representation.

s Taxonomy ID

Identifier for the taxonomy, with the preceding uddi :. The value of tModelKey attribute in
the taxonomy's XML representation.

= Description
Description of the taxonomy (optional).
The second section is Origin, which shows:
= Resource URL
REST interface URL enabling the published taxonomy to be viewed on the server.
= Value Display Format
These options allow changing how the value is presented.

o Categories Tab
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The Categories tab enables you to change the structure and properties of taxonomy categories.
You can use the Categories tab to do the following:

= "Adding a Category" (on page 23)

= "Removing a Category" (on page 23)

= "Copying a Category" (on page 23)

= "Moving a Category" (on page 24)

¢ Advanced Tab
The Advanced tab enables you to set properties used with UDDI.

Itis divided into the following sections:
= Compatibility

Enables you to select one or more of the main UDDI structures for the taxonomy. For
example, businessEntity, businessService, bindingTemplate, and tModel.

All structure types are selected by default which is the required setting if you want your
taxonomy to integrate with UDDI Registry.

= Categorization
Enables you to select from the following taxonomy types:
o categorization

Tags the UDDI structure with additional information, such as identity, location, and
description.

o categorizationGroup

Groups several categorizations into one logical category. For example, a
categorizationGroup could be a geographical location comprised of two
categorizations: longitude and latitude.

The categorizationGroup optionis disabled if the taxonomy has any categories.
o ldentifiers
Reference published information in businessEntities and tModels.
o Relationships
Defines the relationship between two businessEntities in Publisher Assertions.
= Validation

Sets whether or not the values in keyedRe ferences within the taxonomy are checked. The
validation service can check the expected syntax of values. For example, a credit card
number or an ISBN number.

Validation can be against Taxonomy Editor's internal validation service or against an external
service.

To select an external validation service, do one of the following:
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o Enter the endpoint URL.
o Leave keyedReferences unvalidated.
= Reference
Enables you to add a reference to a key type.
= Value Type
Enables you to Select a Value type for keyvalues, using one of the following comparators:
o systinet-com.comparator.string
keyValues are treated as string values. The maximum length is 255 characters.
o systinet-com.comparator.numeric

keyValues are treated as decimal numbers. The value can have a maximum of 19 digits
before the decimal point and a maximum of 6 digits after the decimal point.

o systinet-com.comparator.date
keyValues are treated as dates.

o custom
Endpoint URL of a custom comparator.

¢ Source Tab

The Source tab enables you to view and directly edit the XML representation of the taxonomy.
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Chapter 2

Getting Started

This chapter describes the prerequisites for working with taxonomies in Taxonomy Editor. It
contains the following sections:

¢ "Installing Workbench" (on page 15)

o "SSL Configuration" (on page 16)

o "Customizing Taxonomy Editor" (on page 18)

o "Creating a Taxonomy Project" (on page 17)

¢ "Downloading Taxonomies from a Server" (on page 18)

e "Searching for Taxonomies" (on page 18)

Installing Workbench

HP EM is an Eclipse development platform distributed as a zip file, hp-em-workbench-1.00-
win64.zip.

Note: For supported platforms and known issues, see release-notes.doc alongside the
archive.

Note: HP EM requires Java SE Development Kit (JDK) 1.7.0 (64 bit version only) or higher. You
must include the path to this version of the JDK in the JAVA HOME environment variable.

To Start HP EM Workbench:
o Execute WB_HOME/workbench/start.exe.
The first time you start Workbench, the welcome screen opens.

Select one of the options to open one of the editor tools, start a new editing project, or view the
documentation set.

You can return to the welcome screen from any of the editor tools by selecting Help>Welcome
from the menu options.

By default, Workbench runs in 'normal' mode which prevents users from uploading system
taxonomies (IDs start with uddi: systinet.com: soa:model: taxonomies)and the Report
Editor . rptlibrary file to HP EM servers. If you need to work with system taxonomies or want
toupload the . rptlibrary file you can switch Workbench into 'admin' mode.

Caution: Be extremely careful when working with system taxonomies, HP EM uses some hard-
coded values from system taxonomies, changing or removing them may cause errors.

To Switch Workbench to Admin Mode
1. OpenWB HOME/configuration/config.ini withatext editor.

2. Addmode=admintoconfig.ini.

3. Restart Workbench.
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Tip: HP EM Workbench is memory-intensive. If you experience performance issues, HP
recommends increasing the memory allocation.

To increase the memory allocation for HP EM Workbench:
1. OpenWB HOME/workbench/start.ini forediting.
2. Setthese new values:
= -Xms1l28m
m -Xmx1024m
3. Saveyour changes.
4. Restart Workbench.

Tip: HP EM Workbench downloads from HP EM may time out. If you experience issues, HP
recommends increasing the time out.

To increase the time out for HP EM Workbench:

1. OpenWB_ HOME/workbench/start.ini (oreclipse.ini for stand-alone installation) for
editing.

2. Set the new value:
-Dorg.systinet.platform.rest.Client.timeout=200000
The value is in milliseconds with a default value of 120000 (2 minutes).

3. Saveyour changes.

4. Restart Workbench.

SSL Configuration

By default, Workbench trusts all HP EM server certificates. You may want Workbench to verify HP
EM certificates.

To Verify HP EM Server Certificates:

¢ Add the following options to WB_ HOME /workbench/start.ini:

-Dcom.hp.systinet.security.ssl.verifyCert=true
-Djavax.net.ssl.trustStore=USER TRUSTSTORE
-Djavax.net.ssl.trustStorePassword=TRUSTSTORE PASS
-Djavax.net.ssl.trustStoreType=TRUSTSTORE FORMAT

If HP EM is configured for 2-way SSL, you must provide Workbench certificates to HP EM.
To Provide Workbench Client Certificates to HP EM:

o Add the following options to WB_ HOME /workbench/start.ini:

-Djavax.net.ssl.keyStore=USER KEYSTORE
-Djavax.net.ssl.keyStorePassword=KEYSTORE PASS
-Djavax.net.ssl.keyStoreType=KEYSTORE FORMAT
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Creating a Taxonomy Project

To work with taxonomies, you need a Taxonomy Project. You can create any number of Taxonomy
Projects to help organize your work.

To Create a Taxonomy Project:

1. Do one of the following:

In the Workbench Welcome page, click Create Taxonomy Project.

Click New "~ " to open the Select a Wizard window, and select HP EM>Taxonomy
Project.

From the menu, select File>New>Taxonomy Project.

Press Alt+Shift+N, and then press R, to open the Select a Wizard window. Then select HP
EM>Taxonomy Project.

The New Taxonomy Project dialog box opens.

2. Inthe New Taxonomy Project dialog box, enter the following parameters:

Parameter Definition

Project The name of your assertion project.
Name

Taxonomy The URN prefix to apply to all taxonomies in the project.

ID Prefix

Create from | Select this option if you want to create a new project from a previous
Existing taxonomy extension. If selected, input the path or browse for the location of
Extension the taxonomyn extension.

Use Default | If selected, Taxonomy Editor stores the project in your default workspace. If
Location unselected, input the path or browse for an alternative workspace.

3. Click Nextto select or create a server.

Note: If no servers are currently defined, the dialog box continues to "Creating a Taxonomy

Project" (on page 17).

4. Do one of the following:

Select Create a New Server, and click Next.

Continue to "Creating a Taxonomy Project" (on page 17).

Select Use an Existing Server, select the server from the list and input its credentials, and
then click Next.

Continue to "Creating a Taxonomy Project" (on page 17).

5. Inthe New Server dialog box, add the required parameters, and then click Next.

6. Select the taxonomies to download from the server. Optionally, select Show System
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Taxonomies to view system taxonomies for selection.

7. Click Finish.

Customizing Taxonomy Editor
Some settings are customizable in Taxonomy Editor.
To Change Taxonomy Editor Preferences:
1. Select Window>Preferences.
The Preferences dialog box opens.
2. Inthe tree menu, select HP EM>Taxonomy Editor.
3. You can change the following:
» Default taxonomy namespace

The default namespace setting is 5.5. However, version 5.5 taxonomies cannot be used in
HP SOA Registry Foundation 5.0. Make sure you select the appropriate setting.

= Data consistency

Select Validate before publishing taxonomies to validate changes before publishing
them to the server

Downloading Taxonomies from a Server

Initially, Taxonomy Editor does not contain any taxonomies. To edit HP EM taxonomies, you must
download them from a server.

To Download Taxonomies from a Server:

1. In Server Explorer, right-click the server containing the taxonomies you need to open its
context menu, and select Download Taxonomies.

The Download Taxonomies wizard opens.
2. Select the taxonomies to download and click Next.
The Choose Location dialog box opens.
3. Select the project to add the taxonomies to, and then click Finish.

Taxonomy Editor displays the download progress. When the download is complete, the taxonomies
are visible in Project Explorer.

Searching for Taxonomies
This section describes the search facilities provided by Taxonomy Editor.
Quick Find is the easiest way to find a taxonomy.

To use Quick Find:
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1. Do one of the following:
= Click Search, and then select Quick Jump.
n Press Ctri+J.

The Find Taxonomy dialog box opens. For details, see "Find Taxonomy Dialog" (on page 37).

2. Intheinput field, enter a search string.
3. Click View Menu ~, and then select one of the following options:
= Show in the tree without opening detail
Shows the taxonomy in the tree but does not open its details page.
= Case-sensitive
Enables a case-sensitive or case-insensitive search.
4. Inthe in project field, select in which project to search for the taxonomy.
Taxonomies that match your search criteria are displayed in the Matching taxonomies pane.
5. Select the required taxonomy and click Open taxonomy.
The taxonomy opens in the Editor pane.
For a more detailed search, you can use Advanced Search to do the following:
e Search for a specific property type.
o Search according to a specific value of a property.
o Search different text strings: full text, regular expression, or whole word.
To Use Advanced Search:
1. Do one of the following:
= Select Search>Search.
= Press Ctrl+H.
The Search dialog box opens.

2. Select the Taxonomy Search tab to open the dialog box. For details, see "Search Taxonomy
Dialog" (on page 38).

3. IntheContaining text field, do one of the following:
= Enterthe text to search.
= Select text used in a previous search by using the drop-down list.
4. Insearch only in, choose the taxonomy properties or categories to search.
5. InSearch controls, select one or more of the following:
= Case-sensitive
To perform a case-sensitive search.

= Whole words only
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To search for whole word matches.
= Regular expression
To search using regular expressions.
6. InScope, select one of the following:
= Workspace
To search the Eclipse workspace.
= Selected resources
To search all entities selected in Project Explorer.
= Working set
To customized resources from Project Explorer.
7. Click Choose.
The Select Working Sets wizard opens.
Do one of the following:
= Select from existing working sets.
= Create new working sets.
8. Click Search.

The results are displayed in the Search view of the Ul.
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Managing Taxonomies

This chapter describes how to work with taxonomies, as detailed in the following sections:

"Creating Taxonomies" (on page 21)

"Editing Taxonomies" (on page 21)

"Editing Categories" (on page 22)

"Deleting and Restoring Taxonomies" (on page 24)

"Comparing Taxonomy Files" (on page 25)

"Updating Taxonomies from the Server" (on page 25)

"Importing and Exporting Taxonomy Files" (on page 25)

Creating Taxonomies

In "Creating a Taxonomy Project" (on page 17), you created a Taxonomy Project and looked at how
to download taxonomies. The following section describes how to create new taxonomies.

To Create a New Taxonomy:

1.

Do one of the following:

= Click New ~ " to open the Select a Wizard dialog box, and select HP EM>Taxonomy, and
then click Next.

= Select File>New>Taxonomy.

= Press Alt+Shift+N to open the context menu, and then select Taxonomy.
The New Taxonomy wizard opens.

In the New Taxonomy wizard, enter the required parameters.

Note: A default Taxonomy ID and Filename are assigned according to the Taxonomy Name
entered. The Source Folder is assigned by default, according to whether there is an
active extension project. You can change these parameters to meet your requirements.

Click Finish to create the taxonomy.
The taxonomy is now visible in Project Explorer and the Taxonomy Editor opens.

Open the Categories tab and add the categories you need. For details, see "Editing
Categories" (on page 22).

Open the Advanced tab and enter the required parameters, as described in "Editor View" (on

page 12).

Editing Taxonomies

A taxonomy can be modified in the following ways:
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o "Editing Taxonomy Properties" (on page 22)

o "Refreshing Taxonomies to Reflect External Changes" (on page 22)

o "Copying Taxonomies" (on page 22)

Editing Taxonomy Properties
To Edit Taxonomy Properties:

1. Double-click the taxonomy in Project Explorer to open the Editor view.

2. Edit properties as required in the tabs of the Editor view. For details, see "Editor View" (on page

12).
3. Click Save.

The changed status of the taxonomy is displayed in Project Explorer.

Refreshing Taxonomies to Reflect External Changes

If you want the Editor to reflect changes made outside Taxonomy Editor, you can refresh the
taxonomy.

To refresh a taxonomy, do one of the following:

« Right-click the individual taxonomies or the project in Project Explorer to open the context menu,

and then select Refresh.
o Select the individual taxonomies or the project in Project Explorer, and then press F5.
The selected taxonomies are then updated to reflect external changes.
Copying Taxonomies
You can copy or move taxonomies from one project to another using cut, copy, or paste.
To Copy or Move a Taxonomy to a Different Project:
1. Right-click the taxonomy in Project Explorer and select Copy or Cut.
2. Right-click the project to which you want to copy or move the taxonomies and select Paste.
The taxonomies are then either copied or moved to the other project.
A pasted taxonomy has the status:
e New
If a taxonomy of that name is new to that location.
¢ Modified

If an existing taxonomy is overwritten.
Editing Categories
A taxonomy can be modified in the following ways:

e "Adding a Category" (on page 23)

o "Removing a Category" (on page 23)
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o "Copying a Category" (on page 23)

o "Moving a Category" (on page 24)

Adding a Category
To Add a New Category to a Taxonomy:

1. Open the required taxonomy in the Editor pane and click the Categories tab.

2. Do one of the following:
= Click Add Next to add a new category at the same level.
= Click Add Child to add a new sub-category.
The New Category wizard opens.

3. Enter the category properties, as follows:
= Name

Name for the category. This represents the value of the ke yName attribute in the
taxonomy's XML representation.

= Value

Identifier for the category. This represents the value of the keyVvalue attribute in the
taxonomy's XML representation.

= Disabled
Select this check box to make sure the category cannot be used in an artifact.
4. Click Finish.
The new category is displayed in Category Structure.

Removing a Category
To Remove a Category:
1. Open the required taxonomy in the Editor pane and click the Categories tab.

2. Right-click the category in the Category Structure pane to open its context menu, and select
Delete.

The deleted category is no longer visible in the Category Structure pane.
Copying a Category
To Copy a Category:
1. Open the required taxonomy in the Editor pane and click the Categories tab.

2. Right-click the required source category in the Category Structure pane to open its context
menu, and then select Copy or Cut.

3. Right-click the required destination category in the Category Structure pane to open its context
menu.

4. Do one of the following:
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= Select Paste to add the category as a sub-category.

= Select Paste as Sibling to add the category at the same level.

Moving a Category
To Move a Category:

1. Open the required taxonomy in the Editor pane and click the Categories tab.

2. Select the required category in the Category Structure pane.

3. Do one of the following:
= Click Up, to move a category up.
= Click Down, to move a category down.
= Click Unindent, to move a category to the left.
= Click Indent, to move a category to the right.

Note: To move multiple categories at the same time, you must select categories that are
consecutive.

Deleting and Restoring Taxonomies
You can also delete taxonomies and restore them from your local history.
To Delete a Local Taxonomy:
1. Right-click the taxonomy in Project Explorer to open its context menu, and then select Delete.
2. Confirm deletion of the taxonomy when prompted.
To Restore a Deleted Taxonomy:

1. Right-click the project in Project Explorer to open its context menu and select Restore from
Local History.

The Restore from Local History dialog box opens.
2. Select the check box of the required taxonomy and click Restore.

3. Download the published taxonomy from the server, as described in “Downloading Taxonomies
from a Server”.

To Delete a Taxonomy from the Server:

1. Right-click the taxonomy in Project Explorer to open its context menu and select HP
EM>Remove from Server.

2. Choose if you also want to delete the local copy.
3. Confirm deletion of the taxonomy when prompted.

Note: Taxonomy Editor automatically performs a data consistency check before removing the
taxonomy from the server. For details, see “Conflict With Server”.
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Comparing Taxonomy Files

If you are importing or exporting taxonomies between servers, it is essential to compare
taxonomies to keep track of changes.

Taxonomy Editor enables you to compare the following taxonomies:
o Local taxonomy against the server taxonomy.

o Server taxonomy against alocal history taxonomy.

To Compare Taxonomies:

Right-click the taxonomies you want to compare in Project Explorer to open a context menu, and
then select one of the following:

o Compare With>Each Other
o HP EM>Compare with the latest on server
o Compare With>Local History

The results are displayed in the Compare view.

Updating Taxonomies from the Server

If the most current version of a taxonomy exists on a server, you can update your local copy to
reflect any changes.

To Update a Local Taxonomy:

« Right-click the taxonomy in Project Explorer to open the context menu, and then select HP
EM>Update from Server.

Note: Confirmation is required to overwrite existing taxonomies.

Importing and Exporting Taxonomy Files
You can import and export taxonomies between your projects and your local file system.
To Import a Taxonomy from your File System:

1. In Project Explorer, right-click the taxonomy project to which you want to import taxonomies to
open its context menu, and then select Import>Taxonomy.

The Import Taxonomies wizard opens. For details, see "Import Taxonomies" (on page 37).

2. Browse for the folder from which you want to export taxonomies in the Folder field.
The selected folder is displayed in the left pane.

3. Click the check box of the chosen folder.
Compatible file types are displayed in the right pane.

4. Click the check box of the files you want to import and, and then browse for the required import
folderinthe Into folder field.

5. Click Finish.
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6. Publish the taxonomies to an HP EM repository, as described in "Publishing Taxonomies" (on

page 27).

Tip: When importing a taxonomy from a file whose file name already exists in the local folder,
Taxonomy Editor asks if you want to overwrite the taxonomy. If you click Yes or Yes To All,
the current taxonomy is updated by attributes and categories from the XML file and its status is
changed to modified.

To Export a Taxonomy:

1. Right-click the taxonomy in Project Explorer to open its context menu, and then select Export
to open the Export wizard. For details, see "Export Taxonomies Wizard" (on page 37).

2. Select the required file type and click Next to open the corresponding wizard.

3. Browse for the required destination and enter the required parameters.

4. Select whether to overwrite existing files.

5. Click Finish.
Note: You can export a taxonomy to any file type supported by Eclipse. For example:
o XMLfile

¢ JAR archive

o EAR-deployable or JAR-deployable archive
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Deploying Taxonomies

This chapter explains how to deploy a set of taxonomies as an Extension Project.

You can publish individual taxonomies as described in "Publishing Taxonomies" (on page 27).

Alternatively, create a taxonomy extension and deploy it as described in the following sections:

o "Building a Taxonomy Extension" (on page 27)

o "Applying Extensions" (on page 28)

+ "Redeploying the EAR File" (on page 31)

Publishing Taxonomies

Publishing is the process of updating changes to an HP EM server.

To Publish a Taxonomy:

« Right-click the taxonomy in the Project Explorer to open its context menu, and then select HP
EM>Upload to Server. Multiple taxonomies may be selected by holding CTRL and selecting

them.

The taxonomy is published to the defined HP EM server.

Caution: You cannot publish a System taxonomy to a remote repository.

The status of a taxonomy after publishing updates as described in the following table.

Taxonomy Status After Publication

Status Description Impact
UP-TO- Local and server versions are Publication was successful, including any
DATE identical. modifications.
NEW 2 Local version of the taxonomy has not | Publication was unsuccessful and the
been published to the server. status is unchanged. Possibly due to one
of the following:
e Exception error.
o Breach of server data integrity.
MODIFIED | Changes have been made to a local
> version of a taxonomy after it has
been published.
SYSTEM Taxonomies automatically generated | Changes to these taxonomies cannot be
@ by HP EM. For system use only. published.

Building a Taxonomy Extension

After publishing taxonomies, you can create a Taxonomy Extension.
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To Build a Taxonomy Extension:

1. Right-click the taxonomy project in Project Explorer to open its context menu, and expand HP
EM>Build Extension to open the location browser.

2. Enter a name for the extension project and browse for the location you want to save the project
to, and click Save.

All taxonomies from the selected taxonomy project are copied to the Taxonomy Extension.
Applying Extensions

You can extend HP EM by adding libraries or JSPs to the deployed EAR files, by modifying the
data model, by configuring the appearance of the Ul, and by importing prepackaged data.

Extensions to HP EM come from the following sources:
o Customization Editor

Typical extensions created by Customization Editor contain modifications to the data model,
and possibly data required by the customization (taxonomies). They may also contain new web
components, which may include custom JSP and Java code.

Caution: If your extension contains new artifact types, HP EM does not create default ACLs for
them. Set default ACLs for the new artifact types in HP EM.

o Assertion Editor, Report Editor, and Taxonomy Editor

These extensions contain assertion, reporting, and taxonomy data only. They do not involve
changes to the data model.

The Setup Tool opens the EAR files, applies the extensions, and then repacks the EAR files.
Apply extensions according to one of the following scenarios:
« Single-Step Scenario

The Setup Tool performs all the processes involved in applying extensions, including any
database alterations, as a single step.

Follow this scenario if you have permission to alter the database used for HP EM.
To Apply Extensions to HP EM in a Single Step:
a. Make sure that all extensions are in the following directory:

EM HOME/extensions

The Setup Tool automatically applies all extensions in that directory.

Note: If you are applying extensions to another server, substitute the relevant home
directory for EM_HOME.

b. Stop the server.
c. Start the Setup Tool by executing the following command:
EM_HOME/bin/setup.bat(sh)

d. Select the Apply Extensions scenario, and click Next.
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The Setup Tool automatically validates the step by connecting to the server, copying the
extensions, and merging the SDM configuration.

e. Click Next for each of the validation steps and the setup execution.
Note: This process takes some time.
f. Click Finish to end the process.
g. Deploy the EAR file:
o JBoss
The Setup Tool deploys the EAR file automatically.

If you need to deploy the EAR file to JBoss manually, see "Redeploying the EAR File"
(on page 31).

o Other Application Servers

You must deploy the EAR file manually.
h. Restart the server.

Caution: Applying an extension that modifies the SDM model may drop your full text indices.
EM HOME/log/setup.log contains the following line in these cases:

Could not apply alteration scripts, application will continue with
slower DB drop/create/restore scenario.

In these cases, reapply full text indices as described in the Installation and Configuration Guide.
o Decoupled DB Scenario

Database SQL scripts are run manually. The Setup Tool performs the other processes as
individual steps that are executable on demand. This scenario is useful in organizations where
the user applying extensions does not have the right to alter the database, which is done by a
database administrator.

Follow this scenario if the user who applies extensions does not have permission to modify the
database.

To Apply Extensions and Modify the Database Separately:

a. Make sure that all extensions are in the following directory:
EM HOME/extensions
The Setup Tool automatically applies all extensions in that directory.

b. Stop the server.

c. Start the Setup Tool by executing the following command:
EM_HOME/bin/setup -a

d. Select the Apply Extensions scenario, and click Next.

e. Click Next, to execute the extension application, and exit the Setup Tool.

f. Provide the scripts from EM_HOME/sql to the database administrator.
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The database administrator can use all . sql to execute the scripts that drop and recreate
the database schema.

g. Execute the Setup Tool in command-line mode to finish the extension application:
EM_HOME/bin/setup -c
h. Redeploy the EAR file:
o JBoss
The Setup Tool deploys the EAR file automatically.

If you need to deploy the EAR file to JBoss manually, see "Redeploying the EAR File"
(on page 31).

o Other Application Servers

You must deploy the EAR file manually.

Caution: In some specific circumstances (underscores and numbers in property names), extension
application may fail because HP EM cannot create short enough database table names (31
character maximum for most databases).

The errorin setup . 1og resembles the following:

[java] --- Nested Exception ---

[Java] java.lang.RuntimeException: cannot reduce length of identifier
'ry c es Artifact02s c priEspPty0lGroup c priEspPtyOl',
rename identifier elements or improve the squeezing algorithm

[Java] at

com.systinet.platform.rdbms.design.decomposition.naming.impl.
BlizzardNameProviderImpl.getUniquelLimitedLengthName (

BlizzardNameProviderImpl.java:432)

[Javal] at

com.systinet.platform.rdbms.design.decomposition.naming.impl.
BlizzardNameProviderImpl.filterTableName

(BlizzardNameProviderImpl.java:374)

If you do not require backwards compatibility with these older versions, you can change the table
naming algorithm.

To Change the Table Naming Algorithm:

1. OpenEM HOME/lib/pl-repository-old.jar#META-
INF/rdbPlatformContext.xml with atext editor.

2. Inthe rdb-nameProvider bean element, edit the following property element:
<property name="platform250Compatible" value="false"/>
3. SaverdbPlatformContext.xml

This solution only impacts properties with multiple cardinality. If the problem persists or you need to
preserve backwards compatibility, then review the property naming conventions in your extension.
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Redeploying the EAR File

After using the Setup Tool to apply extensions or updates, you must redeploy the EAR file to the
application server. For JBoss, you can do this using the Setup Tool.

To Redeploy the EAR file to JBoss:

1. Stop the application server.

2. Start the Setup Tool by executing the following command:
EM_HOME!/bin/setup.bat(sh)

3. Select the Advanced scenario, and click Next.

4. Scroll down, select Deployment, and then click Next.
When the Setup Tool validates the existence of the JBoss Deployment folder, click Next.

5. Click Finish to close the Setup Tool.

6. Restart the application server.
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Conflicts and Validation Issues

Editing taxonomies can result in validation and conflict issues, as described in the following
sections:

o "Local Validity" (on page 32)

o "Server Conflicts" (on page 32)

o "Repair Action" (on page 32)
Local Validity

By default, the validity of local taxonomies is constantly checked as you modify them.. Invalid
taxonomies are marked in Project Explorer and the associated errors are listed in the Problems
view.

To disable validation, from the menu, deselect Build automatically.

Server Conflicts

A local taxonomy and the version on a server can come into conflict either when the version on the
server is changed or when changes to the local version affect artifacts on the server.

Conflicts are displayed when you try to publish the taxonomy. An error message is displayed,
stating that the taxonomy could not be published.

To help prevent conflicts, you can do the following:

« Right-click the taxonomy in Project Explorer to open its context menu, and then select one of the
following:

= HP EM>Show Taxonomy Usage
All artifacts categorized by the taxonomy are displayed in the Taxonomy Usage view.

= Right-click the taxonomy in Project Explorer to open its context menu, and then select HP
EM>Validate Data Consistency

Conflicts are displayed in the Validation Results view.

Repair Action

The Data Consistency Check reports artifacts that use categories which no longer exist in the
taxonomy project.

Taxonomy Editor features a Repair Action which enables you to resolve these inconsistencies.
To Repair an Inconsistency:

1. Inthe Validation Results view, expand the problem category, and right-click an artifact to open
its context menu, then select one of the following:
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= Remove Referenced Category From Artifact
= Change Category
2. Re-run validation.

Note: Some conflicts relate to the validity of policy and lifecycle data (non-standard artifacts). The
repair actions cannot resolve these conflicts.
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Example: Creating and Publishing a Department
Taxonomy

In this example, you create and deploy a new taxonomy containing the identities of departments in
your organization.

Before proceeding, you must do the following:
¢ Define your HP EM server.

o Update the local taxonomies, as described in "Updating Taxonomies from the Server" (on page

25).

To Create a Department Taxonomy:

1. Create a new taxonomy, entering Departments as the Taxonomy Name.

For details of the procedure, see "Creating Taxonomies" (on page 21).

2. Open the Editor for the Departments taxonomy and select the Categories tab.
3. Add the following categories:

= HR

n T

= Payroll

= Finance

= Sales

s Development

= QA

For details of the procedure, see "Adding a Category" (on page 23).

4. Press Ctrl+S to save the taxonomy.
The Departments taxonomy is now visible in Project Explorer.

5. Right-click the Departments taxonomy to open its context menu, and then select one of the
following:

= HP EM>Publish Taxonomy
To publish the taxonomy to the defined HP EM server.
= HP EM>Publish To Other Server

To publish the taxonomy to a different server.
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Keyboard Shortcuts

Shortcut Action Context

Ctrl+Alt+S Add HP EM server. Global

Ctrl+N New taxonomy. Global

Alt+A, Insert Add next category. Categories
tab

Alt+C Add child category. Categories
tab

Alt+U, Ctri+ArrowUp | Move category up. Categories
tab

Alt+D, Move category down. Categories

Ctrl+ArrowDown tab

AIt+E, CtrI+ArrowLeft | Move category left (unindent). Categories
tab

Alt+l, Move category right (indent). Categories

Ctrl+ArrowRight tab

F2 Navigate to Category Name field. Categories
tab

Esc Ignore changes in current test field and switch to Categories

Category Structure tab

Ctrl+PgDn Switch to next editor tab. Taxonomy
Editor

Ctrl+PgUp Switch to previous editor tab. Taxonomy
Editor

F12 Activate Editor. Global

Ctrl+W, Ctrl+F4 Close current editor. Global

Ctrl+Shift+W, Close all editors. Global

Ctrl+Shift+F4

Ctrl+F6 Go to next editor. Global

Ctrl+Shift+F6 Go to previous editor. Global

Ctri+Shift+E Switch to editor. Global
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Shortcut Action Context
Ctri+J Quick find taxonomy. Global
Ctrl+H Search taxonomy or category. Global
Alt+Shift+W Show editing resource in Taxonomy Editor. Global
F5 Refresh items. Global
Ctrl+S Save changes for active editor. Global
Ctrl+Shift+S Save changes for all editors. Global
Ctrl+C, Ctrl+insert Copy Global
Ctri+X, Shift+Delete Cut Global
Delete Delete Global
Ctrl+V, shift+insert Paste Global
Ctri+Shift+L Show key assist Global
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Dialog Boxes Reference

Each Taxonomy Editor input dialog is described in the following sections:

o "Import Taxonomies" (on page 37)

o "Export Taxonomies Wizard" (on page 37)

o "Find Taxonomy Dialog" (on page 37)

e "Search Taxonomy Dialog" (on page 38)

Import Taxonomies

Select taxonomy files to import into your taxonomy project:

Parameter Definition

Folder Browse for the source folder containing the taxonomy files you want to import.

Left Pane | Select the source folder containing the taxonomy files you want to import.

Right Select the individual taxonomy files you want to import.
Pane

Into Folder | Browse for the destination folder into which you want to import the selected
taxonomies.

Export Taxonomies Wizard

Select a destination for the taxonomies you wish to export:

Parameter Definition

Select an export destination | Enter text to filter your search.

Tree View Select File System as your destination folder.

Select the taxonomies you want to export, then browse for the destination directory:

Parameter Definition

Left Pane | Select the project from which you want to export taxonomies.

Right Pane | Select the individual taxonomies you want to export.

To Browse for and select the directory into which you want to export the selected
Directory | taxonomies.

Find Taxonomy Dialog

A quick search for matching taxonomies:
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Parameter Definition

Top Field Enter text to filter your search results.

Matching Taxonomies | A list of taxonomies matching your search request.

In Project Select the project in which you want to search for taxonomies.

Search Taxonomy Dialog

An advanced search for matching taxonomies:

Parameter Definition
Containing Enter text to search or use the drop-down menu to select a previous search
Text parameter.

Working Set Browse for and select a working set as a scope for your search.
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Troubleshooting
Case Indications Resolution Type Severity
A taxonomy Your local taxonomy is | To replace the local Conflict Error
was changed CONFLICTING. The taxonomy with the server
on the remote local version cannot be | version, use the
server while published and its taxonomy context action
you were modifications are kept. | HP EM>Update
modifying your Taxonomy. You might
local version. want to first copy your
local version to a
temporary location.

A taxonomy Taxonomy is Toreplace the local Conflict Error
was published | CONFLICTING. The taxonomy with the
that has the local version cannot be | remote server version,
same file name | published. Changes to | use the taxonomy
as anew the local taxonomy and | context action HP
taxonomy you | server remain in Project | EM>Update Taxonomy.
are trying to Explorer. You might want to first
publish to the make a backup copy
remote server. your local version.
The taxonomy | The local taxonomy Change the ID of the new | Validation Error
you have cannot be published. taxonomy. Results
created has the | Changes to the local
same|D as an | taxonomy and server
existing remain in Project
taxonomy on Explorer. The
the remote Validation Results
server include a node giving

the taxonomy ID.
You have The local taxonomy To restore the original Validation Error
changed the ID | cannot be published taxonomy, use the Results
of ataxonomy | and remains taxonomy context action
used by MODIFIED. The HP EM>Update
artifacts. Validation Results list | Taxonomy.

artifacts that use the

taxonomy.
A category that | The local taxonomy To restore the original Validation Error
you modified is | cannot be published taxonomy, use the Results
used by other [ and remains taxonomy context action
artifacts. MODIFIED. Validation | HP EM>Update

Results lists artifacts Taxonomy.
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Case Indications Resolution Type Severity
that use the category.
A new An error message for Change taxonomy ID to | Local Error
taxonomy ID is | this taxonomy is another value. Inconsistency
identical to that | shown.
of another local
taxonomy.
Taxonomy ID A warning message for | Change taxonomy ID to | Local Warning
format is this taxonomy is valid format. Inconsistency
invalid. shown.
Category value | An error message for Change the category Local Error
is duplicated by | this taxonomy is value. Inconsistency
another shown.
category in the
same
taxonomy.
Taxonomy file | An error message for Change file name so that | Local Error
name contains | this taxonomy is it does not contain invalid | Inconsistency
invalid shown. character.
character for
REST URL.
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